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About this Manual 
The Oracle Financial Services Enterprise Financial Performance Analytics (OFSEFPA 
6.1.1.0.0) is based upon a dedicated reporting mart built on the new Oracle Financial 
Services Data Foundation v7.4.2.0.0. OFSEFPA v6.1.1.0.0 leverages several components of 
OBIEE technology including Dashboards and Answers. OFSEFPA v6.1.1.0.0 includes various 
Dashboards and Reports for the user to carryout various Enterprise Financial Performance 
based analytics. 

NOTE: Oracle Financial Services Enterprise Financial Performance Analytics (OFSEFPA) 
was previously known as Oracle Financial Services Profitability Analytics (OFSPA). 

Audience 

This Manual is meant for use by the Oracle Financial Services Analytical Applications 
Infrastructure (OFSAAI) System Administrator. It provides step-by-step instructions necessary 
for installing the OFSEFPA v6.1.1.0.0 Product. 

Scope 

This manual provides a step-wise instruction to install the OFSEFPA v 6.1.1.0.0 product in an 
existing OFSAAI hosted in Oracle 11g R2 (11.2.0.2.0) environment. 

Organization of the Manual 

The Installation Manual is organized into the following chapters: 

• Prerequisites section identifies the hardware and base software environment that is 
required for a successful installation and functioning of the OFSAAI Solution. 

• Installing OFSEFPA v6.1.1.0.0 Product section details the pre-installation activities 
followed by a step-by-step instruction on the various installation options. 

• Post Installation Activities section details the steps that are required to be 
performed after a successful installation of the OFSAAI Solution. 

Conventions Used in this Manual 

References to sections or chapters in the manual are displayed in Italics. 

Screen names are displayed in the following manner: 

Introduction screen 

Options and buttons are displayed in Bold. 

Notes are displayed as follows: 

NOTE 

• It is important that the password should be 6 characters long. If you do not adhere to 
this prerequisite, you will see a system message that reads Password must be at 
least 6 characters long. 
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Prerequisites 
The installation process requires certain environmental variables to be set prior to starting the 
installation. You must ensure that these requirements are met before starting the installation. 
You are requested to refer to the Release Notes for the latest updates on hardware or 
software requirements and the OFSAAI Installation Manual for the environment variables. 

Environment 

Installation of OFSEFPA v6.1.1.0.0 Product requires the Oracle 11g R2 (11.2.0.2.0) version of 
OFSAAI v7.3.3.3.0, to be installed in either a single-tier or multi-tier environment. It is implicit 
that all base software versions and patch levels required by the RHEL/OEL-5.3/5.5 version of 
OFSAAI 7.3.3.3.0 is available and adhered to. 

NOTE 

• The OFSEFPA v6.1.1.0.0 installer download contains only the ERwin XML file that is 

required for uploading the model. This file is sufficient to install the v6.1.1.0.0 

product. However, this XML file cannot be opened in the ERwin Data modeler tool 

and hence cannot be used for any data model customization. ERwin file is delivered 

as a patch and need to be downloaded separately. This ERwin file should be used for 

any customization of the data model. Reference bug / patch where ERwin file can be 

downloaded is Bug 18708569. 

Prerequisites 

• The Oracle 11g R2 (11.2.0.2.0) version of OFSAAI v7.3.3.3.0 and OBIEE 11.1.1.7.1 
on any supported operating system once installed must be configured. 

• Oracle Hyperion Essbase 11.1.2 is optional and is required only when data needs to 
be fetched from Cubes. 

• Apply the one-off patches for the following bugs: 

UG 18157182 - UPGRADE OF STRUTS VERSION TO 2.3.16. 

One-Off Patch: - 18157182_GENERIC.zip Version - 7.3.3.3.0 

• In case of an integrated environment, merge the models and proceed with 
incremental model upload. 
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Front-End Access 

• Internet Explorer 8.0/9.0 

• Java Plug-in 1.6.0_21 

• Acrobat Reader 8.0 

• The screen resolutions supported are 1024*768 and 1280*1024 

 NOTE 

• Ensure that Java Plug-in is enabled in the browser settings. 

Integration with Profitability Management 

In case of customers having license to both Profitability Management (OFSPM) application 
and Enterprise Financial Performance Analytics (OFSEFPA) application, the Profitability 
Management (OFSPM application) should be installed first and only then Enterprise Financial 
Performance Analytics application (OFSEFPA) should be installed. This is required because 
the base tables to populate Dimensions & Fact tables of OFSEFPA exist in OFSPM 
Application. Also, the latest version of OFSPM i.e. 6.1.1 should be installed. 
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Installing OFSEFPA v6.1.1.0.0 Product 
Pre-Installation Activities  

The following is the Pre Installation checklist to ensure the readiness to start installing 
OFSEFPA Product: 

• OFSAAI v7.3.3.3.0 must be successfully installed on Oracle 11gR2 (RAC) 
(11.2.0.2.0). 

• If Infrastructure installation is on multitier environment, Execute the following 
commands in the DB Layer terminal: 

chmod -R 777 < ftpshare folder > 

• Navigate to ftpshare folder and set the umask shown as below.  

This is to ensure that all the new files created are having 666 file permissions 
assigned. 

cd < ftpshare folder > 

umask 0000 

• The Config and atomic schema should be two distinct oracle database users. 

• Oracle database User for Atomic schema should have the below grants: 

grant create session to <ORACLE_USER>; 

grant create PROCEDURE to <ORACLE_USER>;  

grant create SYNONYM to <ORACLE_USER>; 

grant create SEQUENCE to <ORACLE_USER>;  

grant create TABLE to <ORACLE_USER>;  

grant create VIEW to <ORACLE_USER>;  

grant create trigger to <ORACLE_USER>; 

grant create type to <oracle_user>; 

grant select on sys.v_$parameter TO <oracle_user>: 

• Copy the entire OFSEFPA v6.1.1.0.0 installer download directory to the server 
location (Including the DataModel directory). Provide read, write, and execute 
permission to all the files present in this directory. 

• Specify the log file path and name in the log4j.xml. Update the “value” attributes 
marked in the following image: 

 
Figure 1: Log4j.xml file configuration 

• Ensure that the path given in the log4j.xml file has read/write/execute permission. 

• Ensure that FICServer is up and running before proceeding for installation. 
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Upgrade Activities 
This section is applicable only for upgrading from earlier version (EFPA v6.1.0.0.0) to the 
current version (EFPA v6.1.1.0.0). 

Back-up of Database schema and Files 

• Take back up of existing config and atomic schema of the information domain that 
has to be upgraded. This can be used to restore the application, in case of any 
failures during upgrade. 

• Take back up of FTPSHARE and $FIC_HOME folders of the existing environment. 

Data Model Changes 

If data model is customized: 

1) Open both the models using ERwin Data Modeler tool. 

2) Go to "Tools" and select "Complete Compare”. 

3) In the Compare window select the existing Datamodel of EFPA on Left Model. 

4) Select extracted EFPA_Datamodel on Right Model. 

5) In "Type Selection" check "Subject Area". 

6) In "Advanced" option un-check ALL except "Auto Close Database/Script Models". 

7) Click "Compare". 

8) Resolve Differences Screen by applying all the changes mentioned in the 
DM_Difference.xls file (attached below) for 6.1.0.0.0 to 6.1.1.0.0 upgrade. 

 

The DM_Differences.xls file contains the following sheets: 

1. New Table 

2. New Columns 

3. Data Type Changes 

4. Click "Finish" and Close 

5. Save the file as XML in "AllFusion Repository Format" 

Example:- EFPA_Datamodel.xml 

NOTE: 

Follow the instructions mentioned in the “Merging Data Model Changes into Existing 
Model.doc” for merging the existing data model with EFPA data model. 

Merging Data Model 
Changes into Existing  

DM_Difference.xls

 

If Data Model upload is done outside installer, perform the following steps: 
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Merging Data Model Changes into Existing Model



Following document provides the  instructions for merging data model changes into existing model with the changes provided in the service pack.

1. Open previous   and new data model using ERwin Data modeler.

2. Go to ‘Tools’ and click ‘Compare’.

3. Select ‘New Data model ‘ as left model .

4. Select ‘existing/customized   Data model’ as Right model.

5. Click Next and Select “Subject Area” under “Type Selection”.

6. In Advance Options screen uncheck “Case sensitive compare”.

7. Click Next and Compare.



Types of Data Model Changes:

1. New Tables

2. Drop table

3. New Columns

4. Dropped Columns

5. Data Type Changes

6. Domain Changes

7. Merging UDP’s (User Defined Properties)

8. Merging Relationships

9. Merging Descriptions

10. Merging Subject Areas









This document explains in detail on moving the above type’s changes into existing model.	
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1. New Tables

Select New Tables given in the Data Model changes excel from the Left side of model and Click “ToRight” in the Resolve Differences window.

           [image: ]





2. Drop Table

 Select tables given in Drop Table list of Data model changes excel from the Right side of the model and click “ToRight” to remove the tables from the existing model.



[image: ]



3. New  Column:

Select and expand the table given in New Column List of Data Model changes excel and select the columns from the Right Side of the Data Model and click “ToRight” for moving the new column into the existing data model.
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4. Drop Column

Select and expand the table given in Drop Column List of Data Model changes excel and select the columns from the Left Side of the Data Model and click “ToRight” to remove the columns from the existing data model.

[image: ]



5. Data Type Changes:-

 Expand the table given in Data Type Change List of Data Model changes excel and select the columns from the Left Side of the Data Model and click “ToRight” to update the data type of the column into existing data model.
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6. Domain Changes

Expand the table given in Domain Change List of Data Model changes excel and select the columns from the Left Side of the Data Model and click “ToRight” to update the data type of the column into existing data model.
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7. Merging UDP (User Defined Properties)

In the Resolve Differences screen expand “Tables” section select table name which is present in both models and has differences.

Select the UDP from the Left model and click “ToRight”.
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8. Merging relationships

In the “Resolve Differences” screen expand “Tables” and select the table present in both the models. Select the “Relationships” differences and click “ToRight” to move the newly added relationships in to the existing model.

[image: ]

NOTE

In order to move the relationships into the existing model Parent table is required to present /moved first and order/parent tables  can be identified from the relationships differences.



9. Adding  Column Descriptions

In the resolve differences screen expand the “Tables” section and select the table present in both the models. Select the column with difference and click ”ToRight” to move the column level Description/Comment difference to existing model.
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10. Subject Area and Drawings

Expand the “Subject Areas”  section in the resolve differences screen and select the new subject area present in the left model and click “ToRight” to move new subject areas into the existing model
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Merging Data Model Changes into Existing Model.docx


New tables

		NEW_TABLES





Dropped tables 

		DROP_TABLES





Dropped Columns 

		TABLE_NAME		COLUMN_NAME		DATA_TYPE		NULLABLE		IS_PK		IS_FK		DOMAIN		DEFAULT_VAL





New Columns

		TABLE_NAME		COLUMN_NAME		DATA_TYPE		NULLABLE		IS_PK		IS_FK		DOMAIN		DEFAULT_VAL

		DIM_LOB		N_LOB_ID		NUMBER(14)		NULL		NO		NO		ID_NUMBER

		DIM_ORG_STRUCTURE		N_ORG_UNIT_ID		NUMBER(14)		NULL		NO		NO		ID_NUMBER

		DIM_ORG_STRUCTURE		V_OCC_CHARTER_ID		VARCHAR2(20)		NULL		NO		NO		IDENTIFIER

		DIM_ORG_STRUCTURE		F_OPERATING_ENTITY		CHAR(1)		NULL		NO		NO		FLAG

		DIM_ORG_STRUCTURE		D_MERGER_DATE		DATE		NULL		NO		NO		DATE

		DIM_ORG_STRUCTURE		F_FINANCIAL_SUBSIDIARY_IND		CHAR(1)		NULL		NO		NO		FLAG

		DIM_ORG_STRUCTURE		F_MERGED_ENTITY_IND		CHAR(1)		NULL		NO		NO		FLAG

		DIM_ORG_STRUCTURE		V_PARTY_ID		VARCHAR2(20)		NULL		NO		NO		IDENTIFIER

		DIM_ORG_STRUCTURE		V_CAPITAL_ADEQUACY_REGULATOR		VARCHAR2(6)		NULL		NO		NO		CODE_ALPHANUMERIC_SHORT_TYPE2

		DIM_PRODUCT		N_INTEREST_ONLY_TERM		NUMBER(5)		NULL		NO		NO		TERM





Data type Change

		TABLE_NAME		COLUMN_NAME		OLD_DATA_TYPE		NEW_DATA_TYPE

		DIM_DATA_ORIGIN		V_DATA_SOURCE_CODE		VARCHAR2(15)		VARCHAR2(20)

		DIM_LOB		V_LINE_OF_BUSINESS_DESC		VARCHAR2(60)		VARCHAR2(255)

		DIM_LOB		V_LEVEL1_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL11_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL10_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL5_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL6_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL7_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL8_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL9_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL12_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL13_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL14_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL15_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL16_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL2_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL3_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)

		DIM_LOB		V_LEVEL4_LOB_CODE		VARCHAR2(6)		VARCHAR2(20)





Not Null Change

		TABLE_NAME		COLUMN_NAME		OLD_NULL_OPTION		NEW_NULL_OPTION

		DIM_REP_LINE		V_REP_LINE_NAME		NULL		NOT NULL





Domain Change

		TABLE_NAME		COLUMN_NAME		OLD_DOMAIN		NEW_DOMAIN

		DIM_DATA_ORIGIN		V_DATA_SOURCE_CODE		CODE_ALPHANUMERIC_MEDIUM_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LINE_OF_BUSINESS_DESC		TEXT_MEDIUM_DESCRIPTION		DESCRIPTION

		DIM_LOB		V_LEVEL1_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL11_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL10_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL5_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL6_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL7_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL8_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL9_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL12_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL13_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL14_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL15_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL16_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL2_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL3_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG

		DIM_LOB		V_LEVEL4_LOB_CODE		CODE_ALPHANUMERIC_SHORT_TYPE2		CODE_ALPHANUMERIC_LONG





PK Change

		TABLE_NAME		COLUMN_NAME		OLD_PK		NEW_PK

		DIM_REPORTING_LINE_ATTR		REPORTING_LINE_ID		NO		YES

		DIM_REPORTING_LINE_ATTR		ATTRIBUTE_ID		NO		YES





FK Change

		TABLE_NAME		COLUMN_NAME		OLD_FK		NEW_FK





Default Val Change

		TABLE_NAME		COLUMN_NAME		OLD_DEF_VAL		NEW_DEF_VAL
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1. Copy the modified datamodel existing into the location 

"ftpshare/*INFODOM*/erwin/erwinXML". (Replace *INFODOM* with the name of the 
information domain) 

2. Perform Incremental/Sliced Model Upload in the information domain where EFPA 
application is installed. 

3. Incremental/Sliced model upload might give errors in case there are NOT NULL 
columns that are being added to a table that already has rows or if the columns that 
are being dropped have values. Check the data model changes excel file for any 
such cases. In such a case, take a backup of the table and truncate the table. After 
successful model upload insert records back into the table with a default value for the 
NOT NULL column. 

Oracle Financial Services Enterprise Financial Performance 
Analytics v6.1.1.0.0 Product Installation 
The OFSAAI Product comprises of components that are installed in Web, Application, and 
Database layers. Hence if you have installed OFSAAI 7.3.3.3.0 in a multi-tier architecture, the 
OFSEFPA Product installer must be invoked on each of the machines that host the OFSAAI 
tier. 

For a Single-tier installation, the installer is required to be invoked only once on the machine 
that hosts all the OFSAAI tiers. 

This section describes the installation process where the Three Product setup components 
are installed on separate machines in with the Product installation on separate machines. 
Machine A will be used to install Product Application Layer components, Machine B will be 
used to install Product Database Layer components and Machine C will be used to install 
Product Web Layer components. 

NOTE 

• This section holds applicable if OFSAAI v7.3.3.3.0 is installed on Oracle 11g on 
separate machines A and B respectively. 

• Refer to section Silent Installation, if a silent installation is required. 

6 
 



 

Machine A – Product App Layer 

Step 1 

To begin OFSEFPA product installation, execute Setup.sh. 

 
Figure 2: Installation Splash Screen 

Step 2 

Upon invoking the installer, the Introduction screen will display the prerequisites for 
installation. Ensure that the prerequisites are satisfied before you proceed. 

 
Figure 3: Introduction Screen  
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Step 3 

Choose the log mode for this installer. If Debug is selected, the Passwords will be printed in 
the Log File. 

 
Figure 4: Log Mode Option Screen 

 

Step 4 

Provide the nine digit Customer Identification number provided during the OFSAAI 
installation. 

 

Figure 5: Customer ID Input Screen 

Click Next to continue. 
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Step 5 

The Pre Setup Information screen requests for setup information. 

Select the appropriate OFSAAI layer that has been installed on the machine. 

Example: Application Layer 

 
Figure 6: Pre Setup Information Screen – Choose Layer to Install 

NOTE 

• For a single-tier OFSAAI v7.3.3.3.0 installation, you must select App Layer, DB Layer, 
and Web Layer. For a multi-tier OFSAAI v7.3.3.3.0 installation, select the 
corresponding layer installed on the machine. 
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Step 6 

This panel seeks infromation on whether a new infodom has to be created or the existing 
infodom to be used for apps installtion. Choose the desired option. 

 
Figure 7: Pre Setup Information Screen – Infodom type 

Click Next to continue. 

Step 7-i 

If the option “New Infodom” was chosen in the previous panel then the following panel will be 
next displayed which will seek information of the following details to create infodom. 

Specify a DB name for the new infodom. Make a TNS entry with the DB name specified in the 
tnsname.ora file in the Oracle server. 

Enter the newly created Atomic Schema User Name, Password, and JDBC URL in relevant 
fields. 

Click Next to continue. 

 
Figure 8: Database details for the new Infodom 

Step 7-ii 
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If the option “New Infodom” was chosen in the previous panel then the following panel will be 
displayed following the panel 7-i which will seek further information of the following details to 
create infodom. 

Specify the name and description for the new infodom to be created.  

Specify a segment name to be created. 

NOTE 

• Segment name and Infodom name should not exceed 10 characters. 

Also specify the Application server and database server log path for infodom maintenance (to 
be created) 

 
Figure 9: Infodom details for creation of new Infodom 

NOTE 

• The OFSAAI user must have a role that is able to perform Add/Modify functions for 
OFSEFPA v6.1.1.0.0 metadata. 

Click Next to continue. 

Step 7-iii 

If the option “New Infodom” was chosen in the previous panel then the following panel will be 
displayed following the panel 7-ii which will display the pre-infodom creation details. Check 
and verify all the details before proceeding to the next step. 
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Figure 10: Pre Infodom Creation Summary 

Click Next to continue creation of information domain. A new information domain is created. 

Step 7-iv 

If the option “Existing Infodom” was chosen in the Step 6 then the following panel will be 
displayed which will prompt to select the infodom from list of infodoms present in the setup, 
enter segment code and enter the application schema’s TNS name. 

NOTE 

• Segment code and Infodom name should not exceed 10 characters. 

 
Figure 11: Installation in Progress 

Step 8 

OFSEFPA v6.1.1.0.0 data model is packaged as part of OFSEFPA v6.1.1.0.0 product 
installer and will be installed as part of the upcoming steps, if required. 

The following screen prompts the user to opt for model upload process through installer. 

 
Figure 12: Pre-Setup Information 

Clicking ‘No’ implies that OFSEFPA v6.1.1.0.0 model has been uploaded into information 
domain prior to this installation. 

Clicking ‘Yes’ will proceed with the OFSEFPA v6.1.1.0.0 model upload process as part of the 
installation. 
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If the user selects “Yes”, Step 9 and 10 will be performed. 

Upon selecting “No..”, Step 9 to 10 will be skipped. 

Click Next to proceed. 

Step 9 

The following panel prompts the user to choose whether the released version of Datamodel or 
the customized datamodel to be uploaded. 

On selecting ‘Released Data Model’ option, installer uploads the OFSEFPA v6.1.1.0.0 data 
model that is packaged as part of the OFSEFPA v6.1.1.0.0 product. 

On selecting ‘Customized Data Model’ option, installer allows the user to select the data 
model.Choose the desired option. 

Click Next to proceed. 

 

Figure 13: Pre – Setup information 

Step 10 

If the option “Customized Data Model” was chosen then the following panel will be displayed 
prompting user to select the customized data model located in the machine. 

Choose the customised datamodel file from the server. 

NOTE:  

• The data model xml file should be available in the server. 

• In case the installation is being performed on an existing information domain, the data 
model that is planned to be selected in this panel should be merged with the data 
model that was previously uploaded in the information domain. 

In case the installation is being performed on a new information domain, data model that is 
either customized or merged with other data models can be selected in this panel. 
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Figure 14: Pre – Setup information 

Step 11 

The following panel displays pre-model upload details. 

Verify the details before proceeding to the next step. 

Click Next to proceed for model upload. 

 
Figure 15: Pre – Model Upload Summary 

Clicking on ‘Next’ will start the model upload process. This process will take some time 
depending on the size of the data model and available physical memory in the environment. 
User will not be able to take any further action on the screen, until the model upload process 
is complete. Also, this step cannot be rolled back. 

If the model upload fails, then a pop-up message with relevant error and the log file path will 
be displayed. 

Review errors and take relevant action. Continue with this step until the model upload is 
successful and the installer takes the user to next step. 

NOTE: 

Some of the common errors during model upload are: 

• Insufficient heap memory on the client machine. 

• Possible reason/resolution: The java memory settings in “reveleusstartup.sh” located 
in $FIC_APP_HOME/common/FICServer/bin directory should be increased. 
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• Error while getting the Erwin File path. 

• Possible reason/resolution: Restart the FICServer. 

• Error in Upload Operation: 

• “FAILED WHILE SUPER CATEGORY - SUB CATEGORY RELATIONS HANDLING 
DELETING” 

• Possible reason/resolution: Incorrect Erwin.xsl file version in 
$FIC_APP_HOME/common/FICServer/conf directory. 

Step 12. 

• In the next screen enter the OFSAAI user ID and click next. 

 

Figure 16: Pre OFSAAI User Id Screen 

Step 13 

This panel displays all the pre-installation summary. 

Verify all details and click Install to proceed. 

 

Figure 17: Pre – Install Summary 

Step 14 

This panel displays the installation process. Wait until it completes. 
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Figure 18: Installation is in progress 

Step 15 

The following screen displays the completion of installation of the OFSEFPA product setup. 

Click Done to exit. 

 
Figure 19: Installation Complete 
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Machine B – Product Database Layer 

Step 1 

To begin OFSEFPA product installation, execute the file Setup.sh. 

 
Figure 20: Installation Splash Screen 

Step 2 

Upon invoking the installer, the Introduction screen will display the prerequisites for 
installation. Ensure that the prerequisites are satisfied before you proceed. 

 
Figure 21: Introduction Screen  

Step 3 

Choose the log mode for this installer. In case, if Debug is selected, the Passwords will be 
printed in the Log File. 

Click Next to proceed. 
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Figure 22: Log Mode Option Screen 

Step 4 

Provide the nine digit Customer Identification number provided during the OFSAAI 
installation. 

 
Figure 23: Customer ID Input Screen 

Click Next to continue. 

Step 5 

The Pre Setup Information screen requests for setup information. 

Select the appropriate OFSAAI layer that has been installed on the machine. 

Example: Database Layer 
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Figure 24: Pre Setup Information Screen – Choose Layer to Install 

NOTE 

• For a single-tier OFSAAI v7.3.3.3.0 installation, you must select App Layer. For a 
multi-tier OFSAAI v7.3.3.3.0 installation, select the corresponding layer installed on 
the machine. 

Step 6 

The following panel will be displayed which will prompt to select the infodom from list of 
infodoms present in the setup, enter segment code and enter the application schema’s TNS 
name. 

NOTE 

• Segment code and Infodom name should not exceed 10 characters. 
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Figure 25: Pre Setup Information Screen 

Step 7 

This panel displays all the pre-installation summary. Verify all details and proceed. 

Click Install to proceed. 

 
Figure 26: Pre – Install Summary 

Step 8 

This panel displays the installation process. Wait until it completes. 

 
Figure 27: Installation is in progress 
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Step 9 

The following screen displays the completion of installation of the OFSEFPA Product Setup. 

Click Done to exit. 

 
Figure 28: Installation Complete 
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Machine C – Product Web Layer 

Step 1 

To begin OFSEFPA product installation, execute the file Setup.sh. 

 
Figure 29: Installation Splash Screen 

Step 2 

Upon invoking the installer, the Introduction screen will display the prerequisites for 
installation. Ensure that the prerequisites are satisfied before you proceed. 

 
Figure 30: Introduction Screen  

Step 3 

Choose the log mode for this installer. In case, if Debug is selected, the Passwords will be 
printed in the Log File. 

Click Next to proceed. 
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Figure 31: Log Mode Option Screen 

Step 4 

Provide the nine digits Customer Identification number provided during the OFSAAI 
installation. 

 
Figure 32: Customer ID Input Screen 

Click Next to continue. 

Step 5 

The Pre Setup Information screen requests for setup information. 

Select the appropriate OFSAAI layer that has been installed on the machine. 

Example: Web Layer 
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Figure 33: Pre Setup Information Screen – Choose Layer to Install 

NOTE 

• For a single-tier OFSAAI v7.3.3.3.0 installation, you must select App Layer, Web 
Layer, and Database layer. For a multi-tier OFSAAI v7.3.3.3.0 installation, select the 
corresponding layer installed on the machine. 

Step 6 

The following panel will be displayed which will prompt to select the infodom from list of 
infodoms present in the setup, enter segment code and enter the application schema’s TNS 
name. 

NOTE 

• Segment code and Infodom name should not exceed 10 characters. 
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Figure 34: Pre Setup Information Screen 

Step 7 

This panel displays all the pre-installation summary. Verify all details and proceed. 

Click Install to proceed. 

 
Figure 35: Pre – Install Summary 

Step 8 

This panel displays the installation process. Wait until it completes. 

 
Figure 36: Installation is in progress 
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Step 9 

The following screen displays the completion of installation of the OFSEFPA Product Setup. 

Click Done to exit. 

 
Figure 37: Installation Complete 
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Silent Installation  
Silent installation is achieved via a properties file [Silent.props] that must be updated with 
proper values, before attempting to install using the silent mode. 

The following table lists all the properties that need to be specified: 

How to install in Silent Mode 
1. The installer folder contains a template file “Silent.template”. 
2. Create a copy of this file and rename the copy as “Silent.props”. 
3. Edit the file “Silent.props” and specify the parameters as per the requirements. 
4. On the UNIX Command prompt, execute the following command: 

Setup.sh SILENT 
5 Refer to the console log or the file preinstall.log file for any error messages. 
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Property Name Description of Property Permissible Values  Comments 

LOG_MODE Mode for logging 0 = Debug  
1= General 

Optional; 
Default : 0 

CUSTOMER_ID Customer id specified 
while installing OFSAAI 

Not Applicable MANDATORY 

OFSAAI_USER_ID Specify the OFSAAI 
Platform user name 

Not Applicable MANDATORY 

INSTALL_DB Install database-tier 
components 

0 = No 
1 = Yes 

Default : 0 

INSTALL_WEB Install Web-tier 
components 

0 = No 
1 = Yes 

Default : 0 

INSTALL_APP Install Application-tier 
components be installed 

0 = No 
1 = Yes 

Default : 0 

INFODOM_NAME Information 
Domain(infodom) 

Not Applicable MANDATORY 

SEGMENT_CODE Segment Code Not Applicable MANDATORY 

Segment Code 
should not exceed 
10 characters 

INFODOM_TYPE New Infodom or Existing 
Infodom 

0 = New 
1 = Existing 

# Specify Infodom 
Type 

Mandatory if this an 
App Layer 
Installation and 
option selected for 
INSTALL_APP=1 

APPL_TNS TNS Name of the Infodom 
database 

Not Applicable MANDATORY 

APPL_USER User-id of the Database 
Schema for new Infodom 

Not Applicable # Mandatory if this 
an App Layer 
Installation and 
want to create a 
new infodom 

# Option selected 
for 
INSTALL_APP=1 
and 
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INFODOM_TYPE=
0 

APPL_PWD Password  of the 
Database Schema for new 
Infodom 

Not Applicable # Mandatory if this 
an App Layer 
Installation and 
want to create a 
new infodom 

# Option selected 
for 
INSTALL_APP=1 
and 
INFODOM_TYPE=
0 

APPL_URL JDBC Connection String of 
the Database Schema for 
new Infodom 

Not Applicable # Mandatory if this 
an App Layer 
Installation and 
want to create a 
new infodom 

# Option selected 
for 
INSTALL_APP=1 
and 
INFODOM_TYPE=
0 

INFODOM_DESC Description for the 
Database Schema for new 
Infodom 

Not Applicable # Mandatory if this 
an App Layer 
Installation and 
want to create a 
new infodom 

# Option selected 
for 
INSTALL_APP=1 
and 
INFODOM_TYPE=
0 

APPFTP_LOG_PATH Infodom Maintenance log 
path(to be created) for the 
new Infodom for applayer 

Not Applicable # Mandatory if this 
an App Layer 
Installation and 
want to create a 
new infodom 

# Option selected 
for 
INSTALL_APP=1 
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and 
INFODOM_TYPE=
0 

DBFTP_LOG_PATH Infodom Maintenance log 
path(to be created) for the 
new Infodom for DBLayer 

Not Applicable # Mandatory if this 
an App Layer 
Installation and 
want to create a 
new infodom 

# Option selected 
for 
INSTALL_APP=1 
and 
INFODOM_TYPE=
0 

UPLOAD_MODEL whether you want to 
perform Model Upload 

0 = No 
1 = yes 

Mandatory if 
INSTALL_APP=1 

MODEL_TYPE Released datamodel or 
Customized datamodel 

0 = released 
1 = customized 

Mandatory if 
INSTALL_APP=1 

DATAMODEL the path  for the 
customized datamodel 

Not Applicable # Mandatory only in 
the case  of 
uploading the 
customized 
datamodel 

# Option selected 
for 
MODEL_TYPE=1 

DM_DIRECTORY the file name for the 
customized datamodel 

Not Applicable # Mandatory only in 
the case  of 
uploading the 
customized 
datamodel 

# Option selected 
for 
MODEL_TYPE=1 
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Post Installation Activities 
OFSAAI Server Memory Configuration 

The OFSAAI Application Server is started using reveleusstartup.sh. This file can be edited for 
setting customized memory settings, garbage collector settings depending on the available 
hardware configuration. Raise an SR in support.oracle.com if you have any queries related 
to EPM applications. 

Once the installation of OFSEFPA Product is completed, you must perform the following 
steps: 

• Check the Log file (The path and file name specified in the log4j.xml). 

Workarounds for Known Issues 

Execute the following workarounds as mentioned in the integrated document/file below the 
bug after installing OFSEFPA 6.1.1.0.0: 

a. Bug 16504664 - CUBES: NOT ABLE TO SAVE HEPMGLFR (REPORTING LINE 
FOR FR) HIERARCHY.  
Workaround – Execute the scripts available in the integrated SQL file below post 
SCD run. 

DIM_GL_ACCOUNT_update_EFPA.sql
 

 
Configuration of OBIEE for OFSEFPA Application 
Make sure Oracle Business Intelligence version 11.1.1.7.1 is available. 

1. Set the <Oracle BI Instance Home> directory> =>. 
For example: /u01/OBIEE11G/instances/instance1 

2. Start Weblogic AdminServer. 
a. Set the < BI Domain Home> directory> => e.g.  

/u01/OBIEE11G/user_projects/domains/bifoundation_domain.  
b. Navigate to < BI Domain Home >/bin and run ‘nohup ./startWebLogic.sh &’ 
c. Bringing up this service may take a few minutes depending on your 

environment.Check the logs using the command ‘tail –f nohup.out’ 
3. Start Node Manager. 

a. Set the < WebLogic Server Home > directory> => e.g.  
/u01/OBIEE11G/wlserver_10.3.  

b. Navigate to <WebLogic Server Home>/server/bin and  
run ‘nohup ./startNodeManager.sh &’. 

4. Start Weblogic Managed Server(bi_server1). 
a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup). 
b. Under Environment block (mid of page, towards left side), click on Servers 

link. 

31 
 

http://support.oracle.com/

update DIM_GL_ACCOUNT set V_GL_ACCOUNT_CODE = v_gl_account_name, v_gl_account_name = 'GL Missing', N_GL_PARENT_ACCOUNT_ID = 0, V_GL_PARENT_ACCOUNT_CODE = 'MSG' where n_gl_account_skey = 0

/

update DIM_GL_ACCOUNT set V_GL_ACCOUNT_CODE = v_gl_account_name, v_gl_account_name = 'GL Others', N_GL_PARENT_ACCOUNT_ID = 0, V_GL_PARENT_ACCOUNT_CODE = 'MSG' where n_gl_account_skey = -1

/

commit

/
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c. The bi_server1 line should show as shutdown state at this point.  

 
d.  Click on control page tab.  

 
e. Select the bi_server1 line by clicking on the left tick box,  
f. Click start button at the top of the list and confirm starting this service  

 
g. State will update to “RUNNING” mode after a few minutes. 

5. Start BIEE services and login  
a. Starting services From EM screen  

i. Login to the EM administration screen using the url 
http://localhost:7001/em (Replace the hostname and port number 
based on your setup). Use the login you created in BIEE installation 
to log in.  

ii. Expand 'Business Intelligence' node on the left and choose 
Coreapplication.  

 
iii. Click on the Overview Tab,  
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iv. Click on blue button ‘Restart’ (or green button ‘Start’ ) under the 
Manage System category, middle of screen,  

v. Click yes on dialog box to confirm the move. Wait for message that 
confirms successful restart.  

b. If starting using EM is not successful and complaining about OPMNCTL not 
up, Follow starting process with OPMNCTL. 

i. Open a command prompt, navigate to <Oracle BI Instance 
Home>/bin.  

ii. run “./opmnctl status, this will show you status of all the OBIEE core 
services. 

iii. run “./opmnctl startall” or “./opmnctl stopall” depending on your need. 
6. Deploy RPD and webcat file(s). 

a. Navigate to folder $FIC_HOME/EFPA/repository, where EFPA61.rpd file is 
present. 
Copy this file into a local folder. 

b. Also navigate to $FIC_HOME/EFPA/catalog folder, where EFPA61.zip file is 
present. This zip file contains the catalog files Financial Reporting.catalog 
and Management Reporting.catalog. 
Copy both these catalog files to the local folder, where EFPA61.rpd has 
been copied. 

c. Login to OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em). 
i. Click on hyperlink ‘coreapplication’ from ‘Business Intelligence’ 

tab on left hand side. 
ii. Under ‘coreapplication’, select the tab ‘Deployment’ and in that 

select sub-tab 'Repository'. 
iii. Click ‘Lock and Edit Configuration’ button located below title 

‘coreapplication’. Following screen is displayed. 

 
iv. RPD Deployment: 

Select ‘Browse’ button available under ‘Upload BI Server 
Repository’ section and select EFPA61.rpd file from the local 
folder. Enter Repository password Admin123. 

v. Web catalog Deployment: 
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• Open the analytics OBIEE URL-

(http://<ipaddress>:<port>/analytics) and login with the 
credentials. 

• Click “Catalog” link available on the top right corner. 

 
• Click “Shared Folders” and then “Un-Archive”. 

 
o Browse the path where “Financial Reporting.catalog” is 

copied in the local folder. Select the file and click “Open”. 
Then click “OK”. 

 
o Click on “Shared Folders” and then on Un-Archive. 

Browse the path where “Management Reporting.catalog” 
is copied in the local folder. Select the file and click 
“Open”. Then click “OK” as shown in below diagram. 

 
o Two new catalogs are available on the left hand side. 

• Click “Dashboard” and click on any of the reports to ensure 
that all the reports are available. 
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vi. Steps to restart all services in OBIEE “Enterprise Manager”. 

 Open the EM OBIEE URL- (http://<ipaddress>:<port>/em) and login with 
the credentials. 

• Click “coreapplication” link. 

 
• Click the “Restart” button. 

 
• Click “Yes” to restart all BI components. 

 
A message is displayed as follows: 

 
• Once restart is done, a confirmation message is displayed as 

follows: 
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7. Configure tnsnames.ora. 

a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin. 
b. Make sure an entry is made in the tnsnames.ora to connect to atomic 

schema of OFSAA application. 
c. Save the tnsnames.ora. 

8. Configure ODBC data source to connect to Oracle BI Server. 
a. Go To Control Panel>Administrative Tools>Data Sources (ODBC). 
b. Select the ‘System DSN’ tab and click ‘Add’ Button. 
c. Select a driver specific to (Oracle BI Server 11g) and click ‘Finish’ Button. 
d. Enter ‘Name’ and ‘Server’ details (Specify the Host Name or IP Address of 

the BI Server and click ‘Next’). 
e. Enter Oracle BI Server login id and password (Enter User Name and 

Password created at the time of OBIEE installation). Click ‘Next’. 
f. Click ‘Finish’. 

9. Modify RDBMS connection pool and set the properties. 
a. Open the OBI Administration tool. 
b. Select Start > Programs > Oracle Business Intelligence > BI Administration. 
c. Select File > Open > Online and select 'EFPA61.rpd' file from the Open 

dialog box. 
d. Enter Repository password as 'Admin123'. 
e. In the "Physical" layer, double-click the "OFSEFPA Connection Pool" to open 

its properties. 
f. In the 'General' tab, edit / check the following entries: 
g. Call Interface: (OCI 10g/11g). 
h. Data source name: <tnsnames.ora entry created in the step 7.b connecting to 

OFSAA atomic schema>. 
i. User name: <enter atomic db user name>. 
j. Password: <enter atomic db user password>. 
k. Confirm password and Click 'OK' to close the window and click 'Save' to save 

the RPD file. 
l. Click 'No' for the Global Consistency Message. 
m. Repeat the steps from 9.f to 9.l to set the connection properties for 

"OFSEFPA Init Block". 
n. Close the RPD file (File / Exit). 

10. In case RPD deployment is done on Essbase then modify ESSBASE connection pool 
and set the properties. 

a. Open the OBI Administration tool. 
b. Select Start > Programs > Oracle Business Intelligence > BI Administration. 
c. Select File > Open > Online and select the cube rpd file created as 

mentioned in the 3rd step (RPD Deployment On Essbase Cubes) of section 
Post-Deployment Activities of OFSEFPA v6.1.1.0.0, from the Open dialog 
box. 

d. Enter Repository password as 'Admin123'. 
e. In the "Physical" layer, double-click the "Connection Pool" under Essbase, to 

open its properties. 
f. In the 'General' tab, edit / check the following entries: 

• Call Interface: (Essbase). 
• Essbase Server: IP Address of Essbase server. 
• User name: <enter Essbase console user name>. 
• Password: <enter Essbase console user password>. 

g. Confirm password and Click 'OK' to close the window and click 'Save' to save 
the RPD file. 
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h. Click 'No' for the Global Consistency Message. 
i. Close the RPD file (File > Exit). 

11. Login into OFSEFPA Application using the URL: http://localhost:9704/analytics. 
(Replace the port number based on your setup). 
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Post-deployment Activities of OFSEFPA v6.1.1.0.0 
 

The following activities have to be done after installing and deploying OFSEFPA v6.1.1.0.0 

OBIEE Configuration  

1) Evaluate Support Level 

Evaluate function is used in filters of many reports. To support the evaluate function in 
reports, the value of EVALUATE_SUPPORT_LEVEL in NQSConfig.INI file of the OBIEE 
server needs to be set as 2.  

Path: 
OBIEEHOME\instances\instance1\config\OracleBIServerComponent\coreapplication_obis1 
File: NQSConfig.INI  

Changes: Set EVALUATE_SUPPORT_LEVEL = 2 from EVALUATE_SUPPORT_LEVEL = 0; 

2) Session variable setting  

'ENTITY' by default picks the lowest of Legal Entities in the alphabetical order. Users can 
also set the default value for Entity, by following these steps: 

a. Open the RPD online. 

b. Under Manage Menu go to Variables and select session variable 'ENTITY'. 

c. Set the default value in default initialize section with any one of the available entity 
name from DIM_ORG_STRUCTURE table in single quotes. For example: '<Entity 
Name>’ 

d. Save and check the global consistency of the RPD. 
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3) RPD Deployment On Essbase Cubes(Optional) 

 During deployment use “Admin123” as EFPA61.rpd repository password. 

 Deployment of RPD on ESSBASE cubes will be done through an xml patch 
(EFPA61_Cube_Patch.xml). The xml has been provided as a part of 
installation and will be present at $FIC_HOME/ EFPA/repository folder. The 
steps to be followed for creating cube related RPD is mentioned in the 
document embedded below: 

Steps_to_create_Cu
be_RPD.doc  

  

4) OFSAAI Startup  

OFSAAI servers need to be restarted, in order to see the transformations in 
the Post Load Transformation screen. 

 

5) Security Roles 

Security roles are created in OBIEE to allow or disallow certain users to see 
selective dashboards and data. To accomplish these user roles can be 
created in OBIEE. This step is optional and the procedure to create user 
roles is mentioned in the embedded document. 

Steps to configure 
user roles.docx

 
 

39 
 


Steps to Create Cube related RPD.


Step 1: Create a folder “xmlpatch” in your system and copy the EFPA61.rpd (Its RDBMS RPD) & EFPA61_Cube_Patch.xml files.  


Step 2: Open the EFPA Repository (EFPA61.rpd) in offline mode. 
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Step3: Give the repository password as “Admin123”
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Step 4: Choose “Merge” option from File Menu.
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Step 5:  On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.
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Step 6: Select the Original Master Repository as “EFPA61.rpd” from xmlpatch folder by clicking select option. 
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Step 7: Give “Admin123” as password for Original repository.
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Step 8: Select the xml patch file from the saved path (xmlpatch folder).
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Step 9: Give “Admin123” as Patch file password.
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Step 10: Change the name of the merged repository to “EFPA61_C1.rpd”
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Step 11: Click on Next


[image: image10.png]/=] Oracle BI Administration Tool - EFPA6Lrpd.

File Edit View Manage Jlools Diagraim Jnindov Help

D & @ @ @ & § Merge Repository Wizard - Select Input Files

e

Presentation

T Balance Shest
@ Financil Rstos

@) Financial Reporting
@ ncome Ststement

N e ot s

Define Merge Stateay

Merge Type: FullReposory Merge @& Patch Repostory Merge

Original Master Repository:

Modified Repostory:

Patch Fie:

Save Merged Repostory as:

IV Equalze during merge.

[D:\1_PFTBL Project_Workle8_InstaletionIngobachine\RPD  select >
Repostory Password: [

[D:\1_PFTBL Project_Work\e8_InstaletionIngobachine\RPD  sekect >
Repostory Password:

[D:\1_PFTBL Project_Workle8_instaletionIngoMachine\RPD select...

Patch Password: #

[D:\1_PFTBL Project_Workie8_InstaletionIngoMachine\RPD | Gelect] »
Repository Password:







If “Merge Repository Wizard – Define Merge Strategy” window opens up then skip the below steps and proceed from “Step :23” onwards. In this case the final Cube Rpd name will be “EFPA61_C1.rpd”. Otherwise proceed ahead with the below steps.

Step 12: Check for global consistency by clicking on “Check Global Consistency Ctrl+K” under “File” menu.  
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Step 13: It should result in no errors. Click on “OK” button.
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Step 14: In “xmlpatch” folder copy “EFPA61_C1.rpd” and paste so that a new duplicate rpd gets created “EFPA61_C1 - Copy.rpd”.
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Step 15: In the currently opened “EFPA61_C1.rpd” click on “Merge…” under “File” menu.
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Step 16:  On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.
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Step 17: Select the Original Master Repository as “EFPA61_C1 - Copy.rpd” from xmlpatch folder by clicking select option. 
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Step 18: Give “Admin123” as password for Original repository.
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Step 19: Select the xml patch file from the saved path (xmlpatch folder).
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Step 20: Give “Admin123” as Patch file password.
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Step 21: Change the name of the merged repository to “EFPA61_Cube.rpd”
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Step 22: Click on Next
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Step 23: The wizard asks for the confirmation for deletion. Please select option “Current” under Decision dropdown. 
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Step 24: Click on Finish.
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It creates a merged repository (EFPA61_Cube.rpd) under xmlpatch folder.


Take the “EFPA61_Cube.rpd” file and deploy it using EM console on the environment where Data is to be fetched from ESSBASE Cubes.

asanjum
File Attachment
Steps to Create Cube related RPD.doc


Step 1: Open Admin Console of OBIEE.

Step 2: Click on Security Realms under Domain Structure.

Step3: Click on myrealm under Realms

[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\1 Open Console.jpg]

Step 4: Click on ‘User and Groups’ and then on ‘Groups’

[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\2 Create new group.jpg]



Step 5: Click on ‘New’ and create two new groups with the names ‘Business Analyst’ and ‘LoBManager’

[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\3 New group.jpg]

Step 6: Click on newly created ‘Business Analyst’ group for assigning parent group.

	[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\4 Give a parent group as BI Authors for Business Analyst.jpg]

Step 7: Create two new users under ‘Users’ tab of ‘Users and Groups’. One user for Business Analyst and another for LoB Manager.

	[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\5 create new user.jpg]

[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\6 create new user.jpg]

Step 8: Map the newly created users to respective groups.

	[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\7 Map this user to the group.jpg]

Step 9: Close the Admin Console of OBIEE.

Step 10: Open Enterprise Manager of OBIEE.

Step11: Navigate to CoreApplication > Security > Singe Sign On > Configure and Manage Application Roles.

	[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\8 Open EM and manage application roles.jpg]

Step 12: Create a new application roles with the name ‘Business Analyst Role’ with display name as ‘Business Analyst Role’ and ‘LoBManager’ with display name as ‘LoB Manager Role’.

	[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\9 Create a new application role.jpg]



[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\91 Create application role with name Business Analyst Role.jpg]

Step 13: Assign Business Analyst Group to its role and similarly ‘LoB Manager’ group to its respective role.

	[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\92 In members section assign Business Analyst group to this role.jpg]

Step14: Unarchive the catalogs by selecting ACL as ‘Preserve’

	[image: E:\OFSA\Fusion\PFTBI\6.1\roles\1 Open Console\Unarchive_catalogs.jpg]

Step15: After un-archiving the catalogs (Financial Reporting.catalog & Management Reporting.catalog) configure the physical tables in database PFTBI_USER_LOB_MAP to create LoB Manager and LoB mapping.

Step 16: Login with corresponding LoB Manager User Id to verify if the respective LoBs are being selected. To verify all the reports, login with Business Analyst user id.



Abbreviations:

LoB- Line Of Business
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Metadata Browser Batches: 

UMM metadata (Hierarchies, Datasets, Measures, Dimensions) can be seen in Metadata 
Browser by executing the Metadata Browser Batches (MDB batches) from the Batch 
Execution screen of OFSAAI. The batch names are mentioned below: 

a) <INFODOM>_MDB 

b) <INFODOM>_MDB_OBJECT_APPLN_MAP 

 

Web Layer 

1. The web.xml under the path $FIC_WEB_HOME\webroot\WEB-INF\ should have 
Resource tag, if not present then add the tag and replace ORDEMO with the 
INFODOM name. 

  <resource-ref> 

   <description>DB ConnectionORDEMO</description> 

   <res-ref-name>jdbc/ORDEMO</res-ref-name> 

   <res-type>javax.sql.DataSource</res-type> 

   <res-auth>Container</res-auth> 

  </resource-ref> 

  Note: Copy the above information into notepad, and then copy it from 
notepad into xml file. Take extra care to avoid copying formatting characters into the xml file. 

2. Configuration in Websphere Application Server 

I. Create JDBC Provider for the configuration of connection pool for the above 
created Infodom. 

II. Create a data source to access the data from the database. 

III. After creating a Data Source, Click the newly created Data Source 
($DATA_SOURCE$) and navigate to the path: Data 
sources>$DATA_SOURCE$>Connection pools. 

And set the values for Connection timeout to 0 seconds, Maximum 
connections to 100 connections, Minimum connections to 10 connections. 

IV. Expand the Server Types under Servers option in the LHS menu. Click on 
WebSphere application servers option. This will display the Application 
Servers page. 

Navigate to the Web Container option of the application server, under 
Custom properties, add a new property 
com.ibm.ws.webcontainer.invokefilterscompatibility and set the value to true 
Save the new property. 

3. Configuration in Tomcat Application Server 
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I. This step is required only when standalone OFSEFPA is installed and none 

of the applications mentioned in point 3 of Pre-requisites section is installed 
in the infodom. Edit the server.xml present under the path 
$TOMCAT_DIRECTORY\conf\ with the below changes, which is required for 
connection pooling. 

Note:  

Copy the following information into notepad, and then copy it from notepad 
into xml file. Take extra care to avoid copying formatting characters into the 
xml file. 

<Context path="/ $CONTEXTNAME$" docBase="    
$APP_DEPLOYED_PATH$ " debug="0" reloadable="true" 
crossContext="true"> 

    <Resource  auth="Container" 

     name="jdbc/$INFODOM_NAME$" 

     type="javax.sql.DataSource" 

     driverClassName="oracle.jdbc.driver.OracleDriver" 

     username="$ATOMICSCHEMA_USERNAME$" 

     password="$ATOMICSCHEMA_PASSWORD$" 

     url="$JDBC_CONNECTION_URL" 

     maxActive="100" 

     maxIdle="30" 

     maxWait="10000" 

     removeAbandoned="true" removeAbandonedTimeout="60" 

    logAbandoned="true"/> 

   </Context> 

 NOTE:  

• Values for the UserName, Password and others mentioned in the above 
server.xml could be replaced as stated below: 

i. $TOMCAT_DIRECTORY$ should be replaced by Tomcat application 
installed path. 

ii. $CONTEXTNAME$ should be replaced by Oracle Financial Services 
Analytical Applications Infrastructure context name. 

iii. $APP_DEPLOYED_PATH$ should be replaced by the Oracle Financial 
Services Analytical Applications Infrastructure application deployed path. 

   iv. $INFODOM_NAME$ should be replaced by Infodom Name. 

 v. $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema 
database user name. 

vi. $TOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema 
database password. 
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vii. $JDBC_CONNECTION_URL should be replaced by JDBC connection 
string. 

   Example: jdbc:Oracle:thin:<IP>:<PORT>:<SID>  

                   jdbc:oracle:thin 10.80.50.53:1521:soluint 

4. Configuration in Weblogic Application Server 

I. Create JDBC Provider for the configuration of connection pool and a data 
source to access the data from the database for the above created Infodom. 

II. After creating a Data Source, Click the newly created Data Source 
($DATA_SOURCE$) and navigate to the path:  

Home >Summary of Services: JDBC >Summary of JDBC Data 
Sources >JDBC Data Source-<INFODDOM_NAME> 

And set the values for Initial Capacity to 10, Maximum capacity to 
100 ,Capacity Increment by 1, Statement Cache Type to LRU and 
Statement Cache size to 10. 

All Oracle Financial Services Analytical Applications Infrastructure 
v7.3 Servers must be shut down. Oracle 11g service must be 
running. 

5. Deploy the EAR or WAR file 

I. If the Web-Server is Tomcat then re-create and re-deploy the WAR 
file    (OFSAAI war file).  

(Refer to: "Create Tomcat WAR Files"  and "Deploy Tomcat WAR Files" 
sections of the Oracle Financial Services Analytical Applications 
Infrastructure 7.3 Installation and configuration Manual).  

Ensure that the previously deployed applications in Tomcat are removed 
before starting the re-deployment. Start all OFSAAI servers. All servers 
should be directly started in the server. 

II. If the Web-Server is WebSphere re-create and re-deploy the EAR file 
(OFSAAI war file).  

(Refer to: "Create WebSphere EAR File"  and "Deploy WebSphere EAR 
Files" sections of the Oracle Financial Services Analytical Applications 
Infrastructure 7.3 Installation and configuration Manual).  

Ensure that the previously deployed applications in WebSphere are 
removed before starting the re-deployment. Start all OFSAAI servers. All 
servers should be directly started in the server. 

III. If the Web-Server is WebLogic re-create and re-deploy the 
EAR/WAR file (OFSAAI war file).  

(Refer to: "Create WebLogic EAR/WAR File"  and "Deploy WebLogic 
EAR/WAR Files" sections of the Oracle Financial Services Analytical 
Applications Infrastructure 7.3 Installation and Configuration Manual).  
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Ensure that the previously deployed applications in WebLogic are removed 
before starting the re-deployment. Start all OFSAAI servers. All servers 
should be directly started in the server. 

IV. Start all Oracle Financial Services Analytical Applications 
Infrastructure v7.3 Servers. 

NOTE:  

• If you need assistance in starting the servers, then refer to Starting Oracle 
OFSAAI Servers in the Installation Guide of Oracle Financial Services 
Analytical Applications Infrastructure 7.3. .profile should be executed before 
starting any activity from the console. 

Additional Configuration 

1. After deploying the latest Web catalog and RPD from the server, the default reporting 
periods have to be set based on users requirements. The default value has to be set 
at the Reporting Period prompts by editing the dashboard and choosing a specific 
value for the reporting period prompt. Following are the dasbhoard pages where the 
default time period is to be selected: 

  a. Financial Reporting>Income Statement>Time_Hierarchy Prompt 

  b. Management Reporting>Balance Sheet> Time Hierarchy Prompt 

  c. Management Reporting>FTP Reports> Time Hierarchy FTP Prompt 

  d. Management Reporting>Income Statement> Time Hierarchy Prompt 

  e. Management Reporting>Key Trends>Time Hierarchy Prompt 

f. Management Reporting>KeyTrends>Balance Trends> 
Time_Hierarchy_Month Prompt 

  g. Management Reporting > Performance Measures> Time Hierarchy Prompt 

2. Create a entry in Setup_Master table to configure the identity codes that are required 
for Financial Reporting dashboard reports.   

V_COMPONENT_DESC as 
"IDENTITY_CODE_PFTBI_FR_UNALLOCATED_DATA" having Identity 
Code value in V_COMPONENT_CODE and V_COMPONENT_VALUE 
columns. 

3. USERGROUP UGEFPAADMIN is seeded, map the USERGROUP to the INFODOM-
SEGMENT pair specified during installation and authorize the same and then map 
the USER to the USERGROUP UGEFPAADMIN. Or else, map the seeded role 
'EFPA Administrator' to the USERGROUP that is used in the setup. 

4. Once the seeded role 'EFPA Administrator' is mapped to the USERGROUP, the 
custom LHS Menu Enterprise Financial Performance Analytics is accessible to the 
user. Seeded Repline Hierarchy, members, and attributes is visible to the user from 
this link. 

5. If OFSEFPA 6.1.1.0.0 is deployed on Oracle ESSBASE Cubes, then the hierarchies 
would need to be resaved in the Business Hierarchy link of OFSAAI. Subsequently, 
rebuild the Oracle ESSBASE Cubes. 
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 OBIEE Installation and Configuration Guide Link 
Refer the following link to down load the OBIEE installation and configuration guide. 
http://www.oracle.com/technology/documentation/bi_ee.html 
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Troubleshooting 
Problem: After logging into OFSEFPA v6.1.1.0.0 Application, if end user experiences an error 
as “Exceeded configured maximum number of allowed output prompts, sections, rows, or 
columns” while accessing reports. 

Solution:  

1. Bring down OBIEE Presentation services. 
2. Locate and take a back up of the file ’Instanceconfig.xml’ in following folder structure 

<Oracle BI Instance 
Home>\config\OracleBIPresentationServicesComponent\coreapplication_obips1 

3. Edit the file. Locate the tab ‘<view>’ which in turn contains ‘<pivot>’ tab in 
instanceconfig.xml. 

4. Paste the following lines in between ‘<pivot>’ and ‘</pivot>’ tab. 
<MaxVisibleColumns>3000</MaxVisibleColumns> 
<MaxVisiblePages>10000</MaxVisiblePages> 
<MaxVisibleRows>50000</MaxVisibleRows> 
<MaxVisibleSections>250</MaxVisibleSections> 
<DefaultRowsDisplayed>30</DefaultRowsDisplayed> 

5. Save the file and restart the presentation services. 
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	1. The web.xml under the path $FIC_WEB_HOME\webroot\WEB-INF\ should have Resource tag, if not present then add the tag and replace ORDEMO with the INFODOM name.
	<resource-ref>
	<description>DB ConnectionORDEMO</description>
	<res-ref-name>jdbc/ORDEMO</res-ref-name>
	<res-type>javax.sql.DataSource</res-type>
	<res-auth>Container</res-auth>
	</resource-ref>
	Note: Copy the above information into notepad, and then copy it from notepad into xml file. Take extra care to avoid copying formatting characters into the xml file.
	2. Configuration in Websphere Application Server
	I. Create JDBC Provider for the configuration of connection pool for the above created Infodom.
	II. Create a data source to access the data from the database.
	III. After creating a Data Source, Click the newly created Data Source ($DATA_SOURCE$) and navigate to the path: Data sources>$DATA_SOURCE$>Connection pools.
	And set the values for Connection timeout to 0 seconds, Maximum connections to 100 connections, Minimum connections to 10 connections.
	IV. Expand the Server Types under Servers option in the LHS menu. Click on WebSphere application servers option. This will display the Application Servers page.
	Navigate to the Web Container option of the application server, under Custom properties, add a new property com.ibm.ws.webcontainer.invokefilterscompatibility and set the value to true Save the new property.
	3. Configuration in Tomcat Application Server
	I. This step is required only when standalone OFSEFPA is installed and none of the applications mentioned in point 3 of Pre-requisites section is installed in the infodom. Edit the server.xml present under the path $TOMCAT_DIRECTORY\conf\ with the bel...
	Note:
	Copy the following information into notepad, and then copy it from notepad into xml file. Take extra care to avoid copying formatting characters into the xml file.
	<Context path="/ $CONTEXTNAME$" docBase="    $APP_DEPLOYED_PATH$ " debug="0" reloadable="true" crossContext="true">
	<Resource  auth="Container"
	name="jdbc/$INFODOM_NAME$"
	type="javax.sql.DataSource"
	driverClassName="oracle.jdbc.driver.OracleDriver"
	username="$ATOMICSCHEMA_USERNAME$"
	password="$ATOMICSCHEMA_PASSWORD$"
	url="$JDBC_CONNECTION_URL"
	maxActive="100"
	maxIdle="30"
	maxWait="10000"
	removeAbandoned="true" removeAbandonedTimeout="60"
	logAbandoned="true"/>
	</Context>
	NOTE:
	 Values for the UserName, Password and others mentioned in the above server.xml could be replaced as stated below:
	i. $TOMCAT_DIRECTORY$ should be replaced by Tomcat application installed path.
	ii. $CONTEXTNAME$ should be replaced by Oracle Financial Services Analytical Applications Infrastructure context name.
	iii. $APP_DEPLOYED_PATH$ should be replaced by the Oracle Financial Services Analytical Applications Infrastructure application deployed path.
	iv. $INFODOM_NAME$ should be replaced by Infodom Name.
	v. $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database user name.
	vi. $TOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database password.
	vii. $JDBC_CONNECTION_URL should be replaced by JDBC connection string.
	Example: jdbc:Oracle:thin:<IP>:<PORT>:<SID>
	jdbc:oracle:thin 10.80.50.53:1521:soluint
	4. Configuration in Weblogic Application Server
	I. Create JDBC Provider for the configuration of connection pool and a data source to access the data from the database for the above created Infodom.
	II. After creating a Data Source, Click the newly created Data Source ($DATA_SOURCE$) and navigate to the path:
	Home >Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data Source-<INFODDOM_NAME>
	And set the values for Initial Capacity to 10, Maximum capacity to 100 ,Capacity Increment by 1, Statement Cache Type to LRU and Statement Cache size to 10.
	All Oracle Financial Services Analytical Applications Infrastructure v7.3 Servers must be shut down. Oracle 11g service must be running.
	5. Deploy the EAR or WAR file
	I. If the Web-Server is Tomcat then re-create and re-deploy the WAR file    (OFSAAI war file).
	(Refer to: "Create Tomcat WAR Files"  and "Deploy Tomcat WAR Files" sections of the Oracle Financial Services Analytical Applications Infrastructure 7.3 Installation and configuration Manual).
	Ensure that the previously deployed applications in Tomcat are removed before starting the re-deployment. Start all OFSAAI servers. All servers should be directly started in the server.
	II. If the Web-Server is WebSphere re-create and re-deploy the EAR file (OFSAAI war file).
	(Refer to: "Create WebSphere EAR File"  and "Deploy WebSphere EAR Files" sections of the Oracle Financial Services Analytical Applications Infrastructure 7.3 Installation and configuration Manual).
	Ensure that the previously deployed applications in WebSphere are removed before starting the re-deployment. Start all OFSAAI servers. All servers should be directly started in the server.
	III. If the Web-Server is WebLogic re-create and re-deploy the EAR/WAR file (OFSAAI war file).
	(Refer to: "Create WebLogic EAR/WAR File"  and "Deploy WebLogic EAR/WAR Files" sections of the Oracle Financial Services Analytical Applications Infrastructure 7.3 Installation and Configuration Manual).
	Ensure that the previously deployed applications in WebLogic are removed before starting the re-deployment. Start all OFSAAI servers. All servers should be directly started in the server.
	IV. Start all Oracle Financial Services Analytical Applications Infrastructure v7.3 Servers.
	NOTE:
	 If you need assistance in starting the servers, then refer to Starting Oracle OFSAAI Servers in the Installation Guide of Oracle Financial Services Analytical Applications Infrastructure 7.3. .profile should be executed before starting any activity ...

	Additional Configuration
	1. After deploying the latest Web catalog and RPD from the server, the default reporting periods have to be set based on users requirements. The default value has to be set at the Reporting Period prompts by editing the dashboard and choosing a specif...
	a. Financial Reporting>Income Statement>Time_Hierarchy Prompt
	b. Management Reporting>Balance Sheet> Time Hierarchy Prompt
	c. Management Reporting>FTP Reports> Time Hierarchy FTP Prompt
	d. Management Reporting>Income Statement> Time Hierarchy Prompt
	e. Management Reporting>Key Trends>Time Hierarchy Prompt
	f. Management Reporting>KeyTrends>Balance Trends> Time_Hierarchy_Month Prompt
	g. Management Reporting > Performance Measures> Time Hierarchy Prompt
	2. Create a entry in Setup_Master table to configure the identity codes that are required for Financial Reporting dashboard reports.
	V_COMPONENT_DESC as "IDENTITY_CODE_PFTBI_FR_UNALLOCATED_DATA" having Identity Code value in V_COMPONENT_CODE and V_COMPONENT_VALUE columns.
	3. USERGROUP UGEFPAADMIN is seeded, map the USERGROUP to the INFODOM-SEGMENT pair specified during installation and authorize the same and then map the USER to the USERGROUP UGEFPAADMIN. Or else, map the seeded role 'EFPA Administrator' to the USERGRO...
	4. Once the seeded role 'EFPA Administrator' is mapped to the USERGROUP, the custom LHS Menu Enterprise Financial Performance Analytics is accessible to the user. Seeded Repline Hierarchy, members, and attributes is visible to the user from this link.
	5. If OFSEFPA 6.1.1.0.0 is deployed on Oracle ESSBASE Cubes, then the hierarchies would need to be resaved in the Business Hierarchy link of OFSAAI. Subsequently, rebuild the Oracle ESSBASE Cubes.
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